e
THE HEX EDITOR

INTRODUCTION

This chapter explains the operation of Resorcerer’'s Hex Editor, which lets
you directly edit the byte data in resources of any type.

If you are not already familiar with general resource editing, see the
“Editing Resources” chapter earlier in the manual.

Toprics CoVvERED

= Opening any resource

< Hex Editor window layout
= Using the Hex Editor

< Editing hex data

< Finding and replacing

< Viewing options

< Printing hex data

< Decompiling hex data

OPENING ANY RESOURCE

The Hex Editor is a general purpose hexadecimal editor that displays and
edits the data from any resource, regardless of type. Internally, all offsets
are computed in full 32-bits so that the Editor handles even the largest
resources. Your Mac's installed memory will, of course, limit the size of any
large resources you can open. Resorcerer’s partition size will be a limiting
factor also.

Resorcerer calls upon the Hex Editor to edit a resource whenever no other
Editor is more appropriate. Since any resource can always be edited in hex,
every File Window contains a special Hex button that directly opens the
resource with the Hex Editor, bypassing any other type-specific editors that
Resorcerer would otherwise use when you click in the Open button. If there
are no appropriate editors for a type, the Open button will call upon the Hex
Editor as the editor of last resort.

365



REsSORCERER UseErR MANUAL

366

Note:

To be consistent with the way Resorcerer identifies Editors, the

Hex Editor has a major resource type of ' HEXA'. When you ask
Resorcerer to create a new resource, for instance, the ‘HEXA' type
appears in the New Resource dialog’s list of known resources.

Hex EpbiTor LAYyouT

Every resource is nothing but a sequence of 0 or more bytes of data. The
Hex Editor lets you view this data in its own editing window, showing each
8-bit byte as a pair of hexadecimal digits. The main part of the window is
the data display area, which is a scrollable list of lines of hex resource data.
In addition, a Cancel button lets you throw away any changes you've made

and closes the editing window.

There are three parts to each line. On the
left, in boldface, you can see the offset of
the first byte of data in the rest of the line.
Initially this offset is shown in hex with
respect to the beginning of the resource data;
you can set offsets to be in decimal and/or
with respect to any other position in the data
(see “Viewing Options” later in this chapter).

The central part of each line consists of pairs
of hex digits, where each pair represents
each byte in the resource data. Every line

i

EHA 177 from Resources.rsrc

Insertion Offset: 1B

©i0B33 O07E 0052 0144 §.8.%.F.
Si01CE 1101 AOOO S2A0 .4, .t
ti00SE 0100 OAOO 0000 §.é&.

- {000z DOOZ 4098 0030 §. .-
©i007E 0050 O0BA O1CE | .V.P.[.=»
©i007E 0052 O0BA O1CG §.7.R.[.
©i007E 0052 O0BA O1C6 §.V.R.J.
$i0000 0201 000Z D100 §. ..

- 0700 OFD4 FFO1 FOOO §. ..
©i0700 ODD4 DOO1 DOOO & ... ¢
©i0700 OBD4 BBO1 BOOO §... <2

S {0700 OFD4 7701 7000 ... ¢

- 0700 OED4 EEOT FOOO :...<0.0.
- {0000 ODEF DODOO DFFA §...00.

: tFFEE DDO1 DOOO 1300 :.00.-...
:i0BF1 EBOZ FFFF FCFA ;.
- 10002 YFFF FFF1 BEO1

Length: BS8

E
Cancel

always has at least one pair of hex digits in it. The Editor separates the hex
data into pairs of bytes to indicate where even word boundaries fall.

On the right side of each line, the Editor displays the same data in character
form. Characters with ASCII values less than $20 (the hex code for the
space character) are considered non-printable, and are shown as periods.

To the right of the data is a scroll bar that lets you position your view to any
byte offset in the data (see “Scrolling the Hex Data” in the next section).

Above the upper left corner of the scrollable area, the Editor displays

information about the current selection. If the selection is empty, then it
shows you the position, as an offset from the beginning of the resource, of the
blinking insertion caret (in the above illustration, it is at 1B, in the fourth
line from the top). If the selection range is non-empty, you can see the



range’s endpoints (again, as offsets from the start of the resource data)
followed by the range length. For certain small range lengths, the Editor
also decodes and displays the selected data in other formats. The most
common of these, for selections of 1, 2, or 4 bytes, is as a decimal number.
You may also want to use Resorcerer’'s Value Converter (in the Edit menu)
to view any 32-bit hex value in a variety of other common formats (for more
information on this, see the “Value Converter” chapter later in the manual).

Note: The selection range values are i
printed enclosed by a square
bracket [ on the left and an open
right parenthesis ) on the right, to
indicate that the offset value of
the byte at the end of the range is
not part of the range, but the first o
byte after the selection. o8

EHA 177 from Resources.rsn

0 OFD4 FFO1 FOOOD
0 0004 DOO1 D000
0700 0BD4 BEO1 EOOO
0700 OFD4 7701 7000
0700 OED4 EEQT FOOO
0000 ODEF DOOO DFFA
:iFFEE DDO1 DOOO 1200
:{0BF1 BBOZ FFFF FCFA |
80: 0002 7FFF FFF1 BEOT §. .

For example, a range of [ 7, 41) Length: B3 A -
has a length of $41 - $07= $3A
bytes, from offset $07 up to but
not including the byte at offset $41.

Below the lower left corner of the scrollable area, the Editor shows you the
current length of the data, measured in bytes. Initially the value is
displayed in hex, but will be in decimal if you have chosen Decimal Offsets
in the Hex menu.

At the bottom of the scroll bar is a grow box that you use ST rEh 177 fromRenon T

to change the size of the editing area and its window to Insertion Dffet: 0
suit your taste. The ZoomBox on the right side of the g Egzg :
window’s drag bar grows the window to the size of the 60144 1.
screen it's on, and back again. A 1i0n
10: noee | £
Whatever width you set the window to, the Editor fills 12: 0100
each line with as much hex data as will fit. However, 18 0002
lines may end early if you have inserted a line break to ic: 00 ¢
start a new paragraph of hex data (for more on this, see :21.§ §§§§
the “Marking Paragraphs” section later on in this 24 00BR |
chapter). The minimum width of the hex data is 2 bytes 2: bt
worth, or four hex digits. ZEiomen
30:{007VE ;.
32:-i0052 .
The GoAway box in the window’s drag bar closes the EE §E§§ ;
resource and saves any changes you may have made to B8

an in-memory copy of the resource, which will be saved
to disk when you next save the entire file.
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SCROLLING THE HEx DATA

The value that the scroll bar represents is the offset of the first visible
byte of data in the window. This offset is always the one displayed on
the left side of the first visible line of data, and it can be either even or
odd.

To scroll a windowful at a time, click in the gray area above or below the
scroll bar’s thumb.

To scroll a line at a time, click on either the up or down arrow in the
scroll bar, or tap the up or down arrow cursor key.

To change the view to a given offset, use Goto/Find/Replace in the
Hex menu (described later on in this chapter).

To scroll one byte at a time, hold the Shift key down and click on the
scroll bar arrow in the direction you wish to scroll.

Note: When scrolling upward a line at a time, the Editor may
need to re-register lines as you scroll across any
paragraph boundaries. This causes a complete redraw of
the displayed lines.

MAKING SELECTIONS

You can click and drag the mouse to
make a selection of any contiguous set of
bytes in the resource data. The
selection begins at the byte boundary
closest to where you clicked the mouse
button, and extends to the byte
boundary closest to where you let go of
the mouse button. Any previous 205 Dana Comn Teae
200 0172 1CF3 0002

selection will be collapsed. JFF COFC 0003 0777

S 7000 2205 OEEF 0000

Length: B38
g Cancel

As you drag the mouse, the current
selection is highlighted in both the hex
data and to the right in the character
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data. The values of the start and end of the range are constantly
updated in the upper left corner of the window, so that you can make
accurate selections in the middle of lines.

You can start your selection in either the hex data or the character
data. When you finish, the selection remains highlighted in the area
you started it in, but is left only outlined in the opposite area.

Note: The current selection remains outlined in both areas
when the window becomes inactive.

To change the active selection highlight from the hex data to the
character data or vice-versa, use Swap Selection in the Hex menu.

To extend a selection without collapsing it when you click, hold the Shift
key down and click the mouse at the new endpoint in the data. If the
offset you click on is after the start of the selection, the Editor adjusts
the end of the selection to where you click. Otherwise, it adjusts the
start of the selection.

To select all the data in the resource, choose Select All from
Resorcerer's Edit menu. To select all the data in a given paragraph,
double-click anywhere within the paragraph. If there are no line
breaks, then double-clicking is the same as Select All.

To move the selection forward or backward by the same amount as the
length of the selection, tap either right or left arrow cursor key.

If the start of the selection has been completely scrolled out of the
window display, you can tap the Enter key to scroll the display so the
start of the selection becomes visible. If the start is already visible but
the end of the selection is not, tapping the Enter key will scroll the view
so that the end of the selection becomes visible.
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THE CURRENT INSERTION PoOINT

As in other Macintosh text editors, when the selection range is empty, it
represents the boundary between two bytes, and is indicated on the
screen by a blinking vertical line, called the insertion caret. In the
upper left corner of the window the Editor constantly shows you the
offset of the insertion caret, so that you know exactly where any byte's
position is, and exactly where any data may be inserted.

Note: The byte whose offset is the same as the caret’s is the byte
that occurs just after the caret.

The insertion caret appears in either the hex data area or the character
data area, but not both. Which area it is in depends on which area you
last clicked within. Any typing of text you do is directed at the current
editing area, either hex or character, and the characters you type are
interpreted differently depending on their destination (for more on this,
see the next section, “Editing Resource Data”).

To change the caret from one area to the other while leaving its offset
the same, use the Hex menu’s Swap Selection command.

To move the insertion point either forward or backward by one byte
position, tap either the right or left arrow cursor key.

MARKING HEX PARAGRAPHS

The Editor supports line breaks at any given offset into the hex data.
These let you create paragraphs of data while you're editing which can
help you mark and decode groups of bytes that logically belong together,
such as an embedded Pascal string, a table, etc. You can also ask the
Editor to display line break relative offsets when you choose Line
break relative offsets from the Hex menu (for more on this, see the
“Viewing Options” section later in the
chapter).

i

Selection Range: [ 1BC, 1EF ) 33 bytes

The Editor marks every line break in e
the offset area to the left of the hex data.
This mark is a horizontal line just above
the offset of the first byte of the new
paragraph. You cannot have more than
one line break at any given offset. Length B38

EHA 177 from Resources.rsrc

03 3000 D000 1F0S

Cancel




To enter a line break, place the insertion caret just in front of the byte
you want to begin on a new line, and then tap the Return key.

To surround the current selection with line breaks, tap the Return key
once to place a line break at the start of the selection, and then again to
insert one at the end of the selection.

The carriage returns you type are not entered as part of your resource
data and cannot replace any selected data. The editor maintains a line
break table separately from the data. You can temporarily suppress all
line breaks when you use Hide Line Breaks in the Hex menu.

Sorcery: To enter a carriage return as data, place the insertion
caret at the proper offset in the character area of the
display. Then tap Return while holding the Option key.
Or you can place the caret at the proper position in the
hex data and type its hex value (0OD) directly.

Sorcery: To determine the length of a paragraph, double-click
within its bounds to select it. The Editor will then display
the length of the selection above the data editing area.

To delete a line break, and thereby merge two paragraphs into one,
place the insertion caret to the left of the first byte of the paragraph.
This will always be on the leftmost edge of the editing area, either hex
or character. Then tap the Delete key once to delete the line break.
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EpiTing HEX DATA

ENTERING NEW DATA

To enter a single byte of data at a particular offset in your resource,
place the insertion caret at that offset in the hex data, making sure it's
correct by checking the displayed offset value in the upper left of the
window. Then type the two hex digits for that byte.

When you type the first hex digit, the Editor inserts a new byte whose
low-order 4 bits have the value you've typed, and whose high-order 4
bits are zero. The insertion caret is advanced by two hex digits.
However, when you type the second hex digit, the Editor shifts the new
byte value over 4 bits, places the second hex digit in the low order 4 bits
of the byte, and leaves the caret in place. This lets you enter only the
lower order hex digit for hex values whose high-order 4 bits are 0.

If you select any data prior to typing a new value, the selected data is
deleted first, so that what you type replaces it.

Sorcery: To enter raw keyboard characters that would otherwise
have meaning to the Editor, such as carriage returns,
cursor arrow keys, or the Delete key, hold the Option key
down and tap the key you want to enter. The insertion
caret or selection highlight should be in the character
editing area on the right for this to work.

DeLETING DATA

To delete a byte of data (which equals 2 hex digits), place the insertion
caret just after it on its line, and tap the Delete key once. Or choose
Clear from the Edit menu. You can do this in either the hex data area
of the window, or the character data area.

To delete a selection from your data, make the selection in either the
hex or character data area, then tap the Delete key. Or choose Clear
from the Edit menu.



CUTTING OR COPYING DATA

To cut or copy a selection from your data, make the selection in either
the hex or character data areas, and then choose Cut or Copy from the
Edit menu.

If your highlited selection is in the hex data area, the hex digits as a
string of text are placed in the Macintosh scrap. You can then paste the
hex digits into any other text editing field or application. If, however,
the highlighted selection is in the character editing area, the command
places the actual character data in the scrap.

PaAasTING DATA

To paste data into your resource, place the insertion caret at the
position in the data where you want to insert the text in the scrap.
Then choose Paste from the Edit menu.

To replace a selection of data with text from the scrap, make the
selection and then choose Paste. For more on replacing, see the next
section, “Finding and Replacing,” in this chapter.

Note: The Paste command only recognizes text scraps.

If the insertion caret or selection is in the hex data area, then the text
you are pasting must consist entirely of hex digits possibly interspersed
with white space characters. White space characters include carriage
returns, tabs, spaces and non-breaking spaces, and all ASCII control
characters. The hex digits can be in either upper or lower case. The
Editor will complain and not allow the paste if it encounters any other
non-hex digit in the text.

Note: The number of hex digits in any text you want to paste
must be even. If it is odd, the Editor will ask if you want
to append a final 0 to the text to make it even. Or you can
Cancel the paste so that you can go back and place the
proper hex text into the scrap.

When the insertion caret or selection is in the character data area, then

the text you are pasting can consist of any character data, and can be
any length (memory permitting).
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FinDING AND REPLACING

The Goto/Find/Replace command in the Hex menu lets you place the
Editor's insertion caret at any given offset in the resource data; specify a hex
or text string to search for and select; specify a replacement string for any
matches of the search string; or replace all such matches at once. This
capability is most often used when you want to patch a resource containing
compiled code in order to fix a simple bug.

When you choose Goto/Find/Replace, the Editor opens a modeless dialog,
called the resource’s Searcher (we thought about calling it the resource’s
Finder, but some fruit company

seems to have trademarked # Searcher for HERA 177 from Resources.rsrc
that name). The Searcher is ORscil Find: | |f[ﬁ
designed to let you perform all
of the above related activities
in one dialog, and to do it
easily from the keyboard. 60 To offset: [0 | (Gote )
Since it is important to be able
to see the data in your resource
editing window while you are searching, the Hex Editor may rearrange your
editing window size and position to keep the two windows from overlapping.

Replace: | | [Replace ]

[ Replace All ] [ Replace & Find ]

Each separately opened resource can have its own Searcher. Every Searcher
contains three text fields and a variety of buttons that let you perform the
searching actions. As you interact with different text fields, the appropriate
button is highlighted as a default button.

When you are done using a Searcher, click in its GoAway box to close it. The
Editor also closes the Searcher when you close the resource it searches.

Sorcery: The Tab key makes the next text field active, and the default
buttons track the active text box. This makes it easy to operate
the Searcher entirely from your keyboard.

Note: Searchers (and the Goto/Find/Replace command) are entirely
private to the Hex Editor. They have nothing to do with
Resorcerer’s Search All... command, which cannot search for hex
digits, only for text data. However, if your resource has been
opened by Resorcerer’'s Search All... command, the Searcher will
be initialized to do an ASCII search with the same search string.
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SEARCHING FOR DATA

To find a piece of hex in your resource data, enter the hex you are
looking for into the text field labeled “Find” at the top of the Searcher.
The hex string can be either upper- or lowercase, but should not have
any non-hex characters in it. Make sure the ASCII box is not checked,
and then click on the Find button to find the next instance of the string
in your resource.

The Searcher scans for a matching piece of data, beginning at the end of
the current selection range. If it finds a match, it selects the matching
data and scrolls the display if the selection is not currently showing. If
the Searcher can't find a match by the time it has scanned to the end of
the resource data, it beeps.

Note: Since the hex data is in a background window, any
matching selection will be outlined rather than
highlighted.

The ASCII checkbox lets you tell the Searcher whether you want the
search string to be interpreted as hex or as ASCII text. When the
ASCII box is checked the search string can be any text, and the
character data area rather than the hex data area, will be searched.

To reset the position in the data from which to start the search, enter
the offset value into the “Go to Offset” field, and click in the Goto
button (for more on this, see “Going to a Particular Offset” later in this
section).

RepLAcING DATA

Once you have found a selected section of your data, you can click on the
Replace button to replace the selection with whatever you enter into
the Searcher’s “Replace” text field. Again, the replacement string must
consist of only upper- or lowercase hex digits if the ASCII box is
unchecked, or any text if the ASCII box is checked.

The Replace button replaces the selection in your resource data, or, if
the selection is empty, it inserts the replacement text at the current
position of the insertion caret.

If the replacement text is empty, then Replace will delete any selection
in your resource data.
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REepPLACING AND FINDING AGAIN

To replace multiple instances of your search text with a replacement,
enter your search text into the “Find” field, and Find the first instance
of your search text. Then enter the replacement text in the “Replace”
field, which will change the default button to Replace and Find. You
can now repeatedly click in the Replace and Find button to make the
change and then move on to the next match. If there are no more
matches, the Searcher will beep.

To ensure that you have found all matches in the resource data, use the
Goto button to place the insertion caret at the start of the resource
before beginning your searching (for more on this, see “Going to a
Particular Offset” later in this section).

RepPLACING ALL MATCHES

If you want the Searcher to search for a given string and replace all
instances of the search text with a replacement text, begin by resetting
the current insertion caret to offset 0. Then enter the two strings in the
appropriate “Find” and “Replace” fields, and click once in the Replace
All button. The Searcher finds all instances and replaces them in your
resource with the replace string. When it finishes, it beeps and displays
the number of replacements it just made.

Replace All is undoable, unless you are low on memory or the resource
is very large.

GoiING To A PAaRTICULAR OFFSET

To place the insertion caret at a given offset in your resource data, type
the offset’s value into the “Go to Offset” text field. This value should be
in hex unless you currently have the Decimal offsets mode turned on
(see “Viewing Options” later in this chapter for more on this).

When the Go to Offset text field is active, the Goto button becomes the
dialog's default button so that you can tap the Return key to scroll the
resource data to the given offset. The byte of data at that offset will be
the first visible byte in the hex data area of your resource.



VIEWING OPTIONS

The Editor’'s Hex menu lets you set various

i i H i Decimal offsets #1
viewing options, according to your taste or the P o relative offsets o
task at hand. When a particular mode is in Hide line breaks %3
effect, the Editor places a checkmark next to the Eutond from byte count  E

associated menu command.
Goto/Find/Replace... ®6

Find Next Difference

Use Debugger on Data #;
DecimaL OFFSETS

The Decimal offsets mode asks the Hex {L18 HERA 177 from Resources.rsre [l

Editor to display offsets, ranges, and lengths e T T

in decimal rather than hexadecimal. This 150 R00D 52h0 Q0BE v ¢

- 18,5 ;0100 OADOD Q000 §. ..

also affects the way the Searcher interprets 2410002 D002 4098 | .- @

. . 30, ;00320 007E 0050 §.0.%.

the value you type into its “Go to Offset” 30 DOBR 0108 Q078 [

H 48, {007E 0052 OOBA ;.
fleld- 54y {01CE 0000 0201 §.
60, {0002 D100 0700 .
66 {0FD4 FFO1 FOOO .
72, {0700 0004 DOOY .

This helpful mode is provided for_those 2en 2507 B0 008 |3,
programmers who have only 10 fingers on i e e
their hands. Length: 2874,

SET TEXT STYLE

The Set Text
Style... command in [ Textfont — BI:“_“”'B .
the Resource menu Name: [_Monaco | - “a:!] Duou.

- alic utline
IEt_S you view and — TentSize ———— | [ underline []Shadow
ed!t your h_ex data Points: EI [JcCondense []Extend
using any installed
font on the Mac. [ o | (savesok] [ cancer ]
This is useful for 3

larger displays,

where a larger fixed width font is easier on the eyes; or for resources
with international string data in them. Both the hex and the character
areas of the display draw single characters at a time, so if you choose a
variable width font, the spacing may be uneven.

If you click on Save & OK, the type style you choose is recorded in
Resorcerer’s preferences file, so that every time you use the Hex Editor
it displays with your favorite font. If you click on OK, then the change
is only temporary.
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Hiping LINE BREAKS

The Hide line breaks mode temporarily deletes all line breaks and
their associated markings from the display. This is helpful when you
need to count hex bytes across paragraph boundaries.

Line BrReak RELATIVE OFFSETS

The Line break relative offsets mode asks the Editor to show you the
offsets of data relative to the last line break, instead of relative to the
beginning of the resource data.

This is most useful when you need to analyze an embedded structure,
such as a table or Pascal string, in the data.

EHA 177 from Resources.rsrc & [ HEHA 177 from Resources.rsrc

Selection Range: [ 17D, 18A J D bytes Selection Range: [ 17D, 184 ) D bytes
F8:{FODD OOFC EGO0 0O7F FOOD +F8: {FIDD DOFC EGOO0 0O7F FOOD
102: 0100 0010 QOOB FABE OOEBF - +102: {0100 0010 QOOB FABE OOBF

10C: (ESO0 0101 FBFA BEO1 EOOO 0. .. +10C: {ES00 0101 FEFA BEO1 BOOO
116: ; 1000 .. +116: i 1000 ..
118: {0FFA 7700 EOE4 0001 OFF? §.0Ow.00... 118: {0FFA 7700 EOE4 0001 OFFY ©.

122: (FEY? 0170 O0OF OODE FEEE iOw.p
12C: {00FS EZ00 OO3E FEEE O1F0 ;.

+A: iFE?? 0170 00OF OO0OE FEEE iOw.p. ..
+14: i00F2 E200 003E FEEE O1FO0 {.00..
+1E: {0011 000D FCOOD O1DF S0EZ ... .
+28: {0001 03F0D FCOD 0100 00OF §. ..
+32: {0008 FCEE 00 .02
14F - iF0O EOOD 001F FCEE 01BO 00:00. ..
©i10 000F FOV? 0O07F DFOO O1:...
ti01 F?FD 7701 7000 OFOO0 OE:. .
- iFD EEOD FODE 0000 1EFD EE:D0.0O0...
- i01 FOOO 1000 1
juu]

136: 0011 000D FCOD O1DF S0EZ §....
140: {0001 03FD FCOD 0100 QO0OF §. ..
14A: {000E FCEE OO .02,
14F : {FO E00O0 001F FCEBE O1ED 00:00. ..
159: {10 O00F FOV? 007F DFOO 01:. ..
163: {01 F?F0D 7701 7000 OFOO OE: .
160 : |FO EEOO0 FODE 0000 1EFD EE
S i01 FOOD 1000

fFE OO0 OF20 DEQC
B DD 0100
18A: {000F 000 FEBE OOBC DCOO
194: i007E FEBE 01BO OOOF OOOF |.
19E: {FE?7 OODED DCOO OOOF FE?7
1A8: {0170 O0OE O30E EEEE EFDE |.
1B2: 0000 O1FE EEOM FOOO 0DOZ §...
1BC: {0000 DODS DAOO FFO4 3000 §.
1C6: {D0OFF D000 0003 OBEE BEEO O : {DOFF DOOO 0003 OBEE BEEO
100: :DAD0_O40F BEEE BOOOD 0003 +46: (DAD0 040F BEEE BO0O0 0003

Length: B A :
eng Cancel Length: BS A

DOFS0 DEOOD Doo1
oo 0100|
O00F 000E FEBE QOBC DCOO
: {0078 FEEE 0Q1B0 OQOF OOOF .
: {FE?? QOED DCOQ OQOF FE??
: {0170 Q0OE 0Q20E EEEE EFDE | .p....
- {0000 Q1FE EEO1 FOOO ODOZ ...

- {0DDD DDDE DADD FFO4 3000 ;.

When this mode is in effect, the first byte of every paragraph continues
to be displayed relative to the start of the resource, since it would
otherwise always be 0 (an elegant but altogether useless piece of
information). Subsequent lines in the paragraph have offsets that are
preceded by a plus sign ‘+' to indicate that they are relative to the offset
of the beginning of the paragraph.
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ExTeEND FROM BYTE COUNT

Many embedded structures in resource data begin with a count of the
following bytes. Pascal strings, for example, begin with a length byte,
followed by that many bytes. The Extend from Byte Count command
lets you make selections whose length is specified by an initial selection
in the data.

For example, to select an embedded Pascal string, first select its initial
1-byte count, and then choose Extend from Byte Count. To select an
embedded word-length string, select the initial word with the count in it
and choose the command. If the selection is empty, then the first byte
after the insertion caret is used as the byte count.

FinD NexT DIFFERENCE

The Find Next Difference command operates on two simultaneously
opened Hex Editor windows. You can use it to help you track down
differences between the two resources that should be the same.

Starting at the end of the current selection in both windows, the
command searches forward in the data looking for the first different
byte. It then selects that byte in both windows.

Use DEBUGGER ON DATA

If you have a debugger installed in your Mac, such as MacsBug, you can
use it to view the resource data to get a better idea of what it means.

To do this, choose Use Debugger on Data in the Hex menu. This
command invokes your debugger by calling DebugStr with an
argument string that tells you the starting address of the resource data
you are currently editing.

In MacsBug, for instance, you can then issue the IP or IL commands
with the data’s starting address as the argument.

When you are finished viewing your data from within your debugger,

you can get back to the editor when you use the debugger’'s Go
command. In MacsBug, this means simply typing a 3&G.
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Sorcery: Prior to calling the debugger, the Editor locks the handle
to the data. This handle is nearly always in the middle of
the heap. If you do a Heap Dump (in MacsBug, HD) you
can usually find the handle easily, since it will be marked
as locked, but by itself in the middle of the heap.

PrINTING HEX DATA

To print a copy of your Hex editing session, choose Print to Printer from
the File menu. The printout looks basically the same as the scrollable area
of your editing session, printed on as many pages as is necessary.

Any current viewing modes or paragraph breaks remain in effect during
printing. You should make sure the editing area is not too wide before
printing, otherwise bytes on the right may get clipped.

If no hex pairs are selected, the entire resource is printed. If thereisa
selection, then only the lines containing the selected pairs are printed.

DecompPiLING HEXx DATA

To decompile the hex data you are editing, make sure nothing is selected and
choose Copy from the Edit menu. The Editor decompiles the resource into
a Rez declaration of hex data, and the text of this declaration is placed into
the clipboard for you to paste directly into your Rez source file.

Each hex paragraph is decompiled as a separate block labeled with its
starting and ending offsets within the resource. The maximum width of
each hex string is the same as your hex editing window displays. Any
current viewing modes or paragraph breaks remain in effect during printing.

Note: Decompiling using the Copy command only occurs if no selection
is currently in effect. If any bytes in the resource are selected,
only those bytes are placed into the clipboard, either as hex text if
the selection is in the hex editing area, or as pure text if the
selection is in the ASCII editing area.



Sorcery: If you want to decompile only a piece of your resource, mark the
boundaries of the section of hex with returns to turn the section
into a paragraph, then decompile all paragraphs as above. After
you paste the Rez hex strings into your text file, you can then
delete from the text all but the paragraph you are interested in.
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